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                                            5 Introduction Creating Accessible PDF Files from Microsoft Word In Windows, Acrobat installs both an Acrobat PDFMaker toolbar and an Adobe PDF menu in many popular authoring applications. PDFMaker provides conversion settings that let you create tagged accesible PDFs in Microsoft Word, Excel, and PowerPoint. You can use either the toolbar buttons or the Adobe PDF menu to create PDFs, but the menu also provides access to conversion settings. Although many of the conversion options are common to all the Microsoft Office applications, a few are application-specific. Note: For Microsoft Office 2007 applications such as Word, Excel, PowerPoint, and Access, the options for creating PDFs are available from the Acrobat Ribbon. In general, the following rules apply. Design your source document with accessibility in mind Do NOT use character formatting for headings, use the program s styles. Do add alternative text to graphics in the source file Do use a table editor if available to create tables Do NOT use a table editor to design layouts Do generate the PDF file in a way that generates tags Do set your PDF output preferences option to tagged PDF Do check the results in Adobe Acrobat 9 Pro using Advanced > Accessibility > Full Check (shortcut: Alt + A + A + F) Do follow the suggestions for repair and repeat checking until no errors are detected Create an Accessible Microsoft Word Document You should author the original source document with accessibility in mind. This means you should add structure to the document by using styles rather than character formats for such items as headings and lists. You should also add alternate text descriptions to graphics that appear in the Word file using the format picture dialog. You should use Word s column command and not tables to create multi-column documents. Use Styles Design your documents with styles. Styles add the structure necessary to make your documents usable to people with disabilities. Text The default text style for Microsoft Word is Normal. Text should be at least 12 point type. Avoid using Microsoft Word text boxes. Avoid using Enter to create space between paragraphs. Use the space before and space after properties in your styles 1
                                            

                                            6 2 Creating Accessible PDF Files from Microsoft Word Headings Use Styles to create heading formats. Title, Heading 1, Heading 2, Heading 3, etc. Make styles progress in a logical manner, a Heading 2 should come after a Heading 1 Word 2003 Headings To create headings in Microsoft Word 2003 do the following Format > Styles and Formatting to reveal the styles and formatting task pane (See Figure 1 Microsoft Word 2003 Styles and Formatting on page 2). Apply the appropriate heading from the Styles and Formatting panel to your document text Figure 1 Microsoft Word 2003 Styles and Formatting Word 2007 Headings Select the Home Ribbon in Word 2007 and select the proper heading from the styles group (See Figure 2 Microsoft Word 2007 Styles and Formatting on page 2). Figure 2 Microsoft Word 2007 Styles and Formatting Add Alternative Text to Word Graphics and Images Alternative Text or Alt Text refers to text that can be read by a screen reader to describe graphics and images which people with visual dis-abilities cannot see. All Graphics and Images should be provided with
                                            

                                            7 Creating Accessible PDF Files from Microsoft Word 3 alternative text descriptions. Avoid placing graphics too close to text. This can cause problems when converting to PDF. Place white space between text and graphics. Word 2003 Double Click on an image or right click and select the format picture dialog. Select the Web tab and enter the alternative text (See Figure 3 Microsoft Word 2003 Web Tab for adding Alternative Text on page 3). Figure 3 Microsoft Word 2003 Web Tab for adding Alternative Text Word 2007 Right Click on an image and choose Size Select the Alt Text tab and enter the alternative text (See Figure 4 Microsoft Word 2007 Alt Text for adding Alternative Text on page 3) Figure 4 Microsoft Word 2007 Alt Text for adding Alternative Text
                                            

                                            8 4 Creating Accessible PDF Files from Microsoft Word Configure the PDFMaker Once you have authored your Microsoft Word document with accessibility in mind, you are ready to convert it to an accessible PDF file. To generate an accessible PDF document directly from the Microsoft Word source, you should use the Adobe PDFMaker to convert the file to PDF. PDFMaker is an Acrobat feature that operates within many business applications, such as Microsoft Office applications and Lotus Notes. When you install Acrobat, PDFMaker controls appear in the work area of the authoring application. Using PDFMaker within an authoring application is a simple, one-click procedure. It involves clicking an Acrobat PDFMaker toolbar button or choosing a command on the Adobe PDF menu. It is not necessary to open Acrobat. In Windows, Acrobat installs both an Acrobat PDFMaker toolbar and an Adobe PDF menu in many popular authoring applications. You can use either the toolbar buttons or the Adobe PDF menu to create PDFs, but the menu also provides access to conversion settings. Note: For Microsoft Office 2007 applications such as Word, Excel, PowerPoint, and Access, the options for creating PDFs are available from the Acrobat ribbon (See Figure 5 Microsoft Word 2007 Adobe Acrobat Ribbon and Group on page 4). Figure 5 Microsoft Word 2007 Adobe Acrobat Ribbon and Group Show or activate PDFMaker in Microsoft Word If you don t see the PDF toolbar buttons in Microsoft Word, you must show or activate the PDF toolbar. Use one of the following methods to show or activate PDFMaker. For Office 2003 or earlier, Choose View > Toolbars > Acrobat PDFMaker 9.0 For Office 2007 Do the following: Click the Office button, and then click the Word Options button Click Add-Ins on the left side of the dialog box.
                                            

                                            9 Creating Accessible PDF Files from Microsoft Word 5 Do one of the following: If PDFMOutlook or Acrobat PDFMaker Office COM Addin is not listed, choose COM Add- Ins from the Manage pop-up menu and click Go. If PDFMOutlook or Acrobat PDFMaker Office COM Addin is listed under Disabled Application Add-ins, select Disabled Items from the Manage pop-up menu and click Go. Select PDFMOutlook or Acrobat PDFMaker Office COM Addin and click OK. Restart the Office application. View PDFMaker conversion settings PDFMaker conversion settings determine what features of the Microsoft Word document will be included in the PDF and how they will be translated into the resulting PDF file. Do one of the following: Choose Adobe PDF > Change Conversion Settings (See Figure 6 Change PDFMaker Settings in Word 2003 on page 5) Figure 6 Change PDFMaker Settings in Word 2003 (Office 2007) In the Acrobat ribbon, click Preferences (See Figure 7 Acrobat Preferences in Word 2007 on page 5). Figure 7 Acrobat Preferences in Word 2007 If you wish to revert to the original default settings, click Restore Defaults on the Settings tab. Settings Tab The settings available for PDFMaker depend on the application in which you re using PDFMaker (See Figure 8 PDFMaker Settings Tab on page 7).
                                            

                                            10 6 Creating Accessible PDF Files from Microsoft Word Conversion Settings. Specifies the standard by which the PDF will be optimized. When you choose an item in the menu, a description of that preset appears immediately below it. View Adobe PDF Result. Opens the converted document directly into Acrobat. (Exception: when you choose Convert To Adobe PDF And  .) Prompt For Adobe PDF File Name. Lets you enter a custom filename for the resulting PDF. Deselect this option to save the file in the same folder as the source file, using the same name but with a.pdf extension. Convert Document Information. Adds document information from the Properties dialog box of the source file. This setting overrides the printer preferences and settings in the Advanced panel of the Adobe PDF Settings dialog box. Note: The Advanced Settings button opens the Adobe PDF Settings dialog box, which contains many additional conversion options. These conversion settings apply to all Acrobat features that create PDFs, such as Acrobat Distiller, PDFMaker, and the Acrobat application itself. Create PDF/A Compliant PDF File. Creates the PDF so that it conforms to this ISO standard for long-term preservation of electronic documents. (In the Microsoft Publisher application alone, PDFMaker does not support the PDF/A standard.) Note: When Conversion Settings are opened from within Word, Excel, or PowerPoint, this option specifies PDF/A 1-a:2005. When opened from within Microsoft Visio, Access, Microsoft Project, or AutoCAD, it specifies PDF/A 1-b:2005. Attach Source File. Includes the Word document that is being converted as an attachment to the resulting PDF. Create Bookmarks. Converts certain elements in original Office documents to PDF bookmarks: Word headings, Excel worksheet names, or PowerPoint titles. Selecting this option overrides any settings on the Bookmarks tab of the Conversion Settings dialog box. Add Links. Includes active links and hypertext in the PDF. Note: If this option is deselected, but the recipient of the PDF has the Create Links From URLs preference selected, URLs in the PDF are still active. Enable Accessibility And Reflow With Tagged Adobe PDF. Embeds tags in the PDF (on by default).
                                            

                                            11 Creating Accessible PDF Files from Microsoft Word 7 Figure 8 PDFMaker Settings Tab Security Tab The Security tab settings available for PDFMaker depend on the application in which you re using PDFMaker (See Figure 9 PDFMaker Security Tab on page 8). Require A Password To Open The Document. When selected, makes the Document Open Password option available, where you enter a password that users must use to open the document. Restrict Editing And Printing Of The Document. When selected, makes the other Permissions options available. Change Permissions Password. Specifies a password you set that users must use in order to do any allowable printing or editing. Printing Allowed. Specifies whether users who use the Permissions Password can print the document and at what resolution. Changes Allowed. Specifies what kind of changes users who use the Permissions Password can make. Enable Copying Of Text, Images, And Other Contents. Prevents or allows users from copying from the PDF. Enable Text Access For Screen Reader Devices For The Visually Impaired. Prevents or allows screen reader devices to read text. (Selected by default.) Enable Plaintext Metadata. Specifies whether the search engine can read the document metadata. Available only when the PDF-compatibility is set to Acrobat 6.0 (PDF 1.5) or later.
                                            

                                            12 8 Creating Accessible PDF Files from Microsoft Word Figure 9 PDFMaker Security Tab Word Tab Use the Word Tab to control how certain features in Microsoft Word will be rendered in PDF (See Figure 10 PDFMaker Word Tab on page 9). Convert Displayed Comments To Notes In Adobe PDF. Changes any Word comment entries to PDF comments. If the currently open Word document contains comments, more options appear in the Comments list on this tab: Reviewer. Lists the names of reviewers who have entered comments in the current Word document. Include. When deselected, does not include the comments in the PDF. Notes Open. Specifies whether the PDF comment windows automatically open or are closed for that reviewer s comments. Color. Shows the color for that reviewer s comment icons. Clicking the color icon repeatedly cycles through a limited set of available colors. # Of Comments. Shows the number of comments that the reviewer made. Convert Cross-References And Table Of Contents To Links (Word 2002 and 2003 only). Enables one-click navigation of these elements in the new PDF. This option is not available in Word Convert Footnote And Endnote Links. Integrates these into the PDF. Enable Advanced Tagging. Integrates this into the PDF. Useful for Microsoft Word forms.
                                            

                                            13 Creating Accessible PDF Files from Microsoft Word 9 Figure 10 PDFMaker Word Tab Bookmarks Tab (Microsoft Word) The options you specify on this tab determine which items are converted into PDF bookmarks in the PDF (See Figure 11 PDFMaker Bookmarks Tab on page 10). Note: To include bookmarks in the conversion process, the Add Bookmarks To Adobe PDF option on the Settings tab must be selected. If you deselect that option, it overrides any options you select on this tab and no bookmarks are created. Convert Word Headings To Bookmarks. Selects all the headings in the Elements list for conversion to PDF bookmarks. Convert Word Styles To Bookmarks. Selects all the text styles in the Elements list for conversion to PDF bookmarks. (Unselected by default.) Convert Word Bookmarks. Converts any user-created Word bookmarks to PDF bookmarks. Element list. Specifies which Word headings and styles are converted to PDF bookmarks. Element. Lists the names of all available Word headings and styles. The icons for Headings and Styles indicate the element types. Type. Also indicates whether the element is a heading or style in the Word document. Bookmark. Displays X s, indicating whether individual elements are converted to PDF bookmarks. Clicking an individual Bookmark option changes the selection status for that element.
                                            

                                            14 10 Creating Accessible PDF Files from Microsoft Word Level. Specifies where the element fits in the hierarchy structure of the PDF Bookmarks panel. Clicking an individual Level number opens a menu that you can use to change the value. Note: When some but not all of the available Word headings and styles are selected for conversion to PDF bookmarks, the marker in the corresponding check boxes at the top of the tab change. If all elements of the type are selected, a check mark appears. If only some of the elements of that type are selected, a colored square appears. Otherwise, the check box is empty. Figure 11 PDFMaker Bookmarks Tab Video Tab (Microsoft Word and PowerPoint) The options you specify on this tab determine settings for multimedia files that are converted to FLV format and inserted into Word or PowerPoint files (See Figure 12 PDFMaker Video Tab on page 11). Save Video In. To save the converted video file in the same folder as the document, select Same As Document Folder. To save the converted video file in a different folder, select Use This Folder, and click Browse to locate and select a folder. Video Quality. A higher Video Quality setting results in a larger PDF file size. Deinterlace. Activates the video deinterlacing filter, which can improve video quality. Encode Audio. If unselected, the converted video file does not include audio. If selected, specify the data rate at which to encode the audio in the FLV file.
                                            

                                            15 Creating Accessible PDF Files from Microsoft Word 11 Figure 12 PDFMaker Video Tab Settings for Other Microsoft Office Applications There are application specific options on the settings tab of the PDFMaker for other Microsoft Office applications. Excel-specific options on the Settings tab These options are specific to the Settings tab in the PDFMaker for the Microsoft Excel spreadsheet application. Convert Comments. Converts user-created Excel comments to notes and lists them in the Acrobat Comments panel. Fit Worksheet To A Single Page. Adjusts the size of each worksheet so that all the entries on that worksheet appear on the same page of the PDF. Fit To Paper Width. Adjusts the width of each worksheet so that all the columns on that worksheet appear on one page in the PDF. Prompt For Selecting Excel Sheets. Opens a dialog box at the beginning of the file conversion process. In this dialog box, you can specify which worksheets are included in the PDF and the order in which the sheets appear in the PDF. PowerPoint-specific options on the Settings tab These options are specific to the Settings tab in the PDFMaker for the Microsoft PowerPoint presentation application. Convert Multimedia. Converts any linked audio-video file to an FLV file and embeds it in the PDF.
                                            

                                            16 12 Creating Accessible PDF Files from Microsoft Word Preserve Animation (PowerPoint 2002 and 2003 only). Converts any animation effects in the PowerPoint file to equivalent animations in the PDF. This option is not available in PowerPoint Preserve Slide Transitions. Converts PowerPoint slide transition effects to PDF transition effects. Convert Hidden Slides To PDF Pages. Converts any PowerPoint slides that are not seen in the usual playing of the presentation to PDF pages. Convert Speaker Notes. Converts any speaker notes for the PowerPoint presentation into Text notes in the PDF. Use PowerPoint Printer Settings (PowerPoint 2002 and 2003 only). Uses the same printer settings in the PDF as in the original file. This option is not available in PowerPoint Convert the Word Document to Accessible PDF Open the Microsoft Word file. Microsoft Office 2003 There are two controls on the Microsoft Word 2003 interface for converting to accessible PDF (See Figure 13 Convert to Adobe PDF in Word 2003 on page 12). Do one of the following: Click the Convert To Adobe PDF button on the Acrobat PDFMaker toolbar Convert to Adobe PDF from the Adobe PDF menu Figure 13 Convert to Adobe PDF in Word 2003 Enter a filename and location for the PDF, and click Save. Microsoft Office 2007 Do one of the following: Click the Create PDF button from the Create Adobe PDF Group on the Acrobat ribbon (See Figure 14 Create Accessible PDF in Word 2007 on page 12). Figure 14 Create Accessible PDF in Word 2007
                                            

                                            17 Creating Accessible PDF Files from Microsoft Word 13 Select Save as Adobe PDF from the Office button (See Figure 15 Save as Accessible PDF in Word 2007 on page 13). Figure 15 Save as Accessible PDF in Word 2007 Enter a filename and location for the PDF, and click Save. If the Word Document is a Form If the Word document has been designed as a form and you want it to be a fillable PDF form, prepare the document as described. When you are ready to import it into PDF, do so from within Acrobat using the Form Wizard. From Acrobat 9 Pro do the following: Select Forms > Start Form Wizard Check the box indicating An existing electronic document Select Import a file from file system Click the Browse button to locate the desired file Click Next The document will be converted to PDF with Tags and fillable form fields. You may need to edit the results within Acrobat. Check the PDF Version of the Document Using Acrobat Once you have converted the document, you will still need to check the results in Adobe Acrobat. To check the results, refer to the document Adobe Acrobat 9 Pro Accessibility Guide: Using the Accessibility Checker. Depending upon the type of error, you may have to make adjustments in a particular location. Adjustments to the Conversion Settings Repairs You Make to the Source File Repairs You Make to the PDF File
                                            

                                            18 14 Creating Accessible PDF Files from Microsoft Word Changes to the Conversion Settings Some repairs will involve changes to the PDFMaker conversion settings. If, for example, your final check indicated that the PDF file was not tagged, you would need to verify that the Enable Accessibility and Reflow box was checked in the PDFMaker tabbed settings. Repairs You Should Make in the Source File Some repairs can be made on the PDF file, but they would be erased the next time a PDF file was created from the same source. A good example is missing alternative text descriptions. You can certainly use the Touchup Reading Order Tool in Acrobat to add these to a PDF file, but if you want the change to last during updates to the file, it is better to add the alternative text in the Word document using the format picture dialog (See Add Alternative Text to Word Graphics and Images on page 2). Repairs You Should Make in the PDF File Some repairs must take place on the PDF file using Adobe Acrobat 9. Document Language In some instances, even if the document language has been specified in the source file, the information about document language is not conveyed to the PDFMaker. Setting the language for an entire document in the Document Properties dialog box corrects all errors related to this option. Select File > Properties (Ctrl + D) In the Language drop down of the Reading Options section choose the appropriate language for the document. Tab Order is Consistent with Structure Order In some instances, even though the tags have been inherited from the source file, the Accessibility Checker will indicate that tab order is inconsistent with structure order. To correct this issue, do the following: Open the Pages icon or select View > Navigation Panels > Pages (ALT + VNP) Click on any page icon and type Cntrl + A (Command + A for the Mac OS) to select all the pages From the Options button on the pages panel select Page Properties In the Tab Order Panel, check Use Document Structure Establish Table Headings for Tables Table headers are not always properly defined after the conversion from Microsoft Word to PDF. Use the TouchUp Reading Order Table Editor to change table data cells that should be table headings to table headers or change the TD tags directly into TH tags within the tags panel.
                                            

                                                                                
                                
                                
                            



                            
                            
                                                                    
                                        
                                        
                                        
                                        
                                    

                                
                                
                                    
                                        Similar documents
                                        
                                    
                                

                                

    
        Using the Acrobat tab in Microsoft Word: Setting PDF Preferences
    

    
        
        Using the Acrobat tab in Microsoft Word: Setting PDF Preferences IT Documentation Team, January 2015 (Reviewed July 2015) If you have Adobe Acrobat Pro XI installed on your PC 1, you ll see an additional    

    
        More information 
    




    
        Adobe Acrobat 9 Pro Accessibility Guide: Using the Accessibility Checker
    

    
        
        Adobe Acrobat 9 Pro Accessibility Guide: Using the Accessibility Checker Adobe, the Adobe logo, Acrobat, Acrobat Connect, the Adobe PDF logo, Creative Suite, LiveCycle, and Reader are either registered    

    
        More information 
    




    
        http://ipfw.edu Quick Guide for Accessible PDF July 2013 Training: http://ipfw.edu/training
    

    
        
        Accessible PDF Getting Started Types of Documents best suited for PDF on the Web Document is longer than 5 pages. You need to preserve the formatting or layout of the original document, e.g., for printing.    

    
        More information 
    




    
        Create a PDF File. Tip. In this lesson, you will learn how to:
    

    
        
        Create a PDF File Now that you ve seen what an ETD looks like and how to browse the contents, it s time to learn how to convert your own thesis or dissertation into a PDF file. There are several different    

    
        More information 
    




    
        Using Adobe Acrobat X Professional
    

    
        
        Using Adobe Acrobat X Professional Adobe Acrobat X Professional is the version of Acrobat that Publishing uses. This chapter covers the following topics: Configuring Adobe Acrobat Distiller X Creating    

    
        More information 
    




    
        Adobe Acrobat 9 Pro Accessibility Guide: PDF Accessibility Overview
    

    
        
        Adobe Acrobat 9 Pro Accessibility Guide: PDF Accessibility Overview Adobe, the Adobe logo, Acrobat, Acrobat Connect, the Adobe PDF logo, Creative Suite, LiveCycle, and Reader are either registered trademarks    

    
        More information 
    




    
        Adobe Acrobat 9 Pro Accessibility Guide: Creating Accessible Forms
    

    
        
        Adobe Acrobat 9 Pro Accessibility Guide: Creating Accessible Forms Adobe, the Adobe logo, Acrobat, Acrobat Connect, the Adobe PDF logo, Creative Suite, LiveCycle, and Reader are either registered trademarks    

    
        More information 
    




    
        Using the Acrobat X Pro Accessibility Checker
    

    
        
        Contents 1 Accessibility Quick Check 2 Quick Check Results 3 Full Check 5 Accessibility Full Check Options 6 Additional Validation Techniques Using the Acrobat X Pro Accessibility Checker Determine how    

    
        More information 
    




    
        Creating Accessible Adobe PDF Files. A Guide for Document Authors
    

    
        
        Creating Accessible Adobe PDF Files A Guide for Document Authors 2004 Adobe Systems Incorporated. All rights reserved. Adobe, the Adobe logo, Acrobat, Acrobat Capture, the Adobe PDF logo, FrameMaker, GoLive,    

    
        More information 
    




    
        CREATING AN IMAGE FROM AUTOCAD CADD NOTE 16. MENU: AutoCAD, File, Plot COMMAND: plot ICON:
    

    
        
        CADD NOTE 16 This CADD Note provides instructions on creating an image from an AutoCAD drawing that can be pasted into another application (e.g., Word, Powerpoint, etc.). These instructions assume the    

    
        More information 
    




    
        Best practices for producing high quality PDF files
    

    
        
        University of Michigan Deep Blue deepblue.lib.umich.edu 2006-05-05 Best practices for producing high quality PDF files Formats Group, Deep Blue http://hdl.handle.net/2027.42/58005 Best practices for producing    

    
        More information 
    




    
        Adobe Acrobat 9 Pro Accessibility Guide: PDF Accessibility Repair Workflow
    

    
        
        Adobe Acrobat 9 Pro Accessibility Guide: PDF Accessibility Repair Workflow Adobe, the Adobe logo, Acrobat, Acrobat Connect, the Adobe PDF logo, Creative Suite, LiveCycle, and Reader are either registered    

    
        More information 
    




    
        Advanced Presentation Features and Animation
    

    
        
        There are three features that you should remember as you work within PowerPoint 2007: the Microsoft Office Button, the Quick Access Toolbar, and the Ribbon. The function of these features will be more    

    
        More information 
    




    
        Adobe Conversion Settings in Word. Section 508: Why comply?
    

    
        
        It s the right thing to do: Adobe Conversion Settings in Word Section 508: Why comply? 11,400,000 people have visual conditions not correctible by glasses. 6,400,000 new cases of eye disease occur each    

    
        More information 
    




    
        Creating Electronic Portfolios using Microsoft Word and Excel
    

    
        
        Step-by-Step Creating Electronic Portfolios using Microsoft Word and Excel The Reflective Portfolio document will include the following: A Cover Page for the portfolio - Include a Picture or graphic A    

    
        More information 
    




    
        Getting Started Guide. Chapter 10 Printing, Exporting, and E-mailing
    

    
        
        Getting Started Guide Chapter 10 Printing, Exporting, and E-mailing Copyright This document is Copyright 2010 2012 by its contributors as listed below. You may distribute it and/or modify it under the    

    
        More information 
    




    
        Acrobat X Pro Accessible Forms and Interactive Documents
    

    
        
        Contents 2 PDF Form Fields 2 Acrobat Form Wizard 5 Enter Forms Editing Mode Directly 5 Create Form Fields Manually 6 Forms Editing Mode 8 Form Field Properties 11 Editing or Modifying an Existing Form    

    
        More information 
    




    
        Generating lesson plans with. Adobe Acrobat
    

    
        
        Generating lesson plans with Adobe Acrobat Introduction Being a teacher requires so many non-teaching administrative tasks that sometimes just teaching gets lost in the paper shuffle. You can automate    

    
        More information 
    




    
        Creating Accessible PDF Documents with Adobe Acrobat 7.0 A Guide for Publishing PDF Documents for Use by People with Disabilities
    

    
        
        Creating Accessible PDF Documents with Adobe Acrobat 7.0 A Guide for Publishing PDF Documents for Use by People with Disabilities 2005 Adobe Systems Incorporated. All rights reserved. Adobe, the Adobe    

    
        More information 
    




    
        Google Docs Basics Website: http://etc.usf.edu/te/
    

    
        
        Website: http://etc.usf.edu/te/ Google Docs is a free web-based office suite that allows you to store documents online so you can access them from any computer with an internet connection. With Google    

    
        More information 
    




    
        How to create and personalize a PDF portfolio
    

    
        
        How to create and personalize a PDF portfolio Creating and organizing a PDF portfolio is a simple process as simple as dragging and dropping files from one folder to another. To drag files into an empty    

    
        More information 
    




    
        Acrobat X Pro PDF Accessibility Repair Workflow
    

    
        
        Contents 2 Step 1: Examine the PDF File 2 Step 2: Determine if the PDF is a Scanned Document 6 Step 3: Add Interactive Features: Form Fields and Buttons 19 Step 4: Add Other Accessibility Features 23 Step    

    
        More information 
    




    
        Acrobat XI Pro Accessible Forms and Interactive Documents
    

    
        
        Contents 2 Types of interactive PDF Form Fields 2 Automatic Field Detection using the Acrobat Form Wizard 5 Creating a Form without the Forms Wizard 6 Forms Editing Mode 6 Selecting a New Form Field to    

    
        More information 
    




    
        Using FileMaker Pro with Microsoft Office
    

    
        
        Hands-on Guide Using FileMaker Pro with Microsoft Office Making FileMaker Pro Your Office Companion page 1 Table of Contents Introduction... 3 Before You Get Started... 4 Sharing Data between FileMaker    

    
        More information 
    




    
        Introduction to dobe Acrobat XI Pro
    

    
        
        Introduction to dobe Acrobat XI Pro Introduction to Adobe Acrobat XI Pro is licensed under the Creative Commons Attribution-NonCommercial-NoDerivatives 4.0 International License. To view a copy of this    

    
        More information 
    




    
        Creating Interactive PDF Forms
    

    
        
        Creating Interactive PDF Forms Using Adobe Acrobat X Pro Information Technology Services Outreach and Distance Learning Technologies Copyright 2012 KSU Department of Information Technology Services This    

    
        More information 
    




    
        BU Digital Print Service. High Resolution PDFs
    

    
        
        BU Digital Print Service High Resolution PDFs Introduction As part of the BU Digital Print service files can be uploaded to the Web to Print (W2P) portal for printing however the quality of the print is    

    
        More information 
    




    
        July 2012 Version 1.0. Section 508 Compliance Test Process for Microsoft Word Documents
    

    
        
        July 2012 Version 1.0 Section 508 Compliance Test Process for Microsoft Word Documents Contents DHS Section 508 MS Word Test and Reporting Process... 2 DHS Section 508 Compliance Tests for MS Word... 6    

    
        More information 
    




    
        Adobe Acrobat XI Pro Accessibility Guide: Best Practices for PDF Accessibility
    

    
        
        Adobe Acrobat XI Pro Accessibility Guide: Best Practices for PDF Accessibility For more information Solution details: www.adobe.com/accessibility/products/acrobat/ Program details: www.adobe.com/accessibility    

    
        More information 
    




    
        Microsoft SharePoint 2010 End User Quick Reference Card
    

    
        
        Microsoft SharePoint 2010 End User Quick Reference Card Microsoft SharePoint 2010 brings together the people, documents, information, and ideas of the University into a customizable workspace where everyone    

    
        More information 
    




    
        Adobe Acrobat X Pro Forms
    

    
        
        Adobe Acrobat X Pro Forms Course objectives: Create interactive forms Manage form fields and properties Use forms in Adobe Reader Use PDF Actions Digital Signatures This course does not cover LiveCycle.    

    
        More information 
    




    
        HOW TO SAVE AND FILE LOTUS NOTES EMAILS
    

    
        
        Email messages that are university records should be filed and retained with other records to which they relate. Saving emails to a unit s shared drive is an effective way to extract them from the email    

    
        More information 
    




    
        Using Adobe Dreamweaver CS4 (10.0)
    

    
        
        Getting Started Before you begin create a folder on your desktop called DreamweaverTraining This is where you will save your pages. Inside of the DreamweaverTraining folder, create another folder called    
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        Quick Reference Guide
    

    
        
        Quick Reference Guide 2 This Guide shows screen pictures made with Windows XP. The appearance may vary under other Operating Systems. Why are PDF files popular? The Portable Document Format has become    
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        Chapter 12 Creating Web Pages
    

    
        
        Getting Started Guide Chapter 12 Creating Web Pages Saving Documents as HTML Files Copyright This document is Copyright 2010 2012 by its contributors as listed below. You may distribute it and/or modify    
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        Metadata in Microsoft Office and in PDF Documents Types, Export, Display and Removal
    

    
        
        White Paper Metadata in Microsoft Office and in PDF Documents Types, Export, Display and Removal Copyright 2002-2009 soft Xpansion GmbH & Co. KG White Paper Metadata in PDF Files 1 Contents Term Definitions    
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        Guide to the essentials of creating accessible PDFs with Microsoft Word and Acrobat Professional 8
    

    
        
        Guide to the essentials of creating accessible PDFs with Microsoft Word and Acrobat Professional 8 1 Contents Introduction...3 Required software...3 What makes a PDF accessible?...3 Part 1: working in    
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        Excel 2013 What s New. Introduction. Modified Backstage View. Viewing the Backstage. Process Summary Introduction. Modified Backstage View
    

    
        
        Excel 03 What s New Introduction Microsoft Excel 03 has undergone some slight user interface (UI) enhancements while still keeping a similar look and feel to Microsoft Excel 00. In this self-help document,    
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        6. If you want to enter specific formats, click the Format Tab to auto format the information that is entered into the field.
    

    
        
        Adobe Acrobat Professional X Part 3 - Creating Fillable Forms Preparing the Form Create the form in Word, including underlines, images and any other text you would like showing on the form. Convert the    
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        What is a Mail Merge?
    

    
        
        NDUS Training and Documentation What is a Mail Merge? A mail merge is generally used to personalize form letters, to produce mailing labels and for mass mailings. A mail merge can be very helpful if you    
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        PDF Accessibility Overview
    

    
        
        Contents 1 Overview of Portable Document Format (PDF) 1 Determine the Accessibility Path for each PDF Document 2 Start with an Accessible Document 2 Characteristics of Accessible PDF files 4 Adobe Acrobat    
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        INTRODUCTION 5 COLLABORATION RIBBON 5 SELECT THE UPDATING METHOD 6 MAKE YOUR PROJECT COLLABORATIVE 8 PROCESSING RECEIVED TASK UPDATES 9
    

    
        
        Contents Contents INTRODUCTION 5 COLLABORATION RIBBON 5 SELECT THE UPDATING METHOD 6 MAKE YOUR PROJECT COLLABORATIVE 8 PROCESSING RECEIVED TASK UPDATES 9 IMPORT UPDATES 12 CUSTOM TEXT FIELDS MAPPING 13    
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        To determine the fields in a table decide what you need to know about the subject. Here are a few tips:
    

    
        
        Access Introduction Microsoft Access is a relational database software product that you can use to organize your data. What is a "database"? A database is an integrated collection of data that shares some    
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        About XML in InDesign
    

    
        
        1 Adobe InDesign 2.0 Extensible Markup Language (XML) is a text file format that lets you reuse content text, table data, and graphics in a variety of applications and media. One advantage of using XML    
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        Using Acrobat Comment and Markup tools
    

    
        
        Using Acrobat Comment and Markup tools In Adobe Acrobat 9 and Adobe Reader, a comment is a note, highlight, stamp, or any other markup you add to your PDF document by using the comment and markup tools.    
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        Word 2007: Mail Merge Learning Guide
    

    
        
        Word 2007: Mail Merge Learning Guide Getting Started Mail merge techniques allow you to create a document which combines repetitive text elements with data drawn from an external data document. To perform    
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        Windows 10: A Beginner s Guide
    

    
        
        Windows 10: A Beginner s Guide Copyright 2014 Conceptual Kings. All are rights reserved. This book or any portion thereof may not be reproduced or used in any manner whatsoever without the express written    
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        There are several ways of creating a PDF file using PDFCreator.
    

    
        
        it Information Information Technology Services Introduction Using you can convert virtually any file from any application into Adobe Portable Document Format (PDF). Documents in Adobe PDF preserve the    
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        Computer Skills: Levels of Proficiency
    

    
        
        Computer Skills: Levels of Proficiency September 2011 Computer Skills: Levels of Proficiency Because of the continually increasing use of computers in our daily communications and work, the knowledge of    
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        Page 1. 1.0 Create and Manage a Presentation 1.1 Create a Presentation Pages Where Covered
    

    
        
        Page 1 Study Guide for MOS Objectives in Microsoft PowerPoint 2013 Illustrated 1.0 Create and Manage a Presentation 1.1 Create a Presentation creating blank presentations 6 creating presentations using    
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        COMBINING FILES IN PDF PORTFOLIOS
    

    
        
        5 COMBINING FILES IN PDF PORTFOLIOS Lesson Overview In this lesson, you ll learn how to do the following: Quickly and easily combine files of different types into one PDF Portfolio. Customize the look    
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        Activities/ Resources for Outcome #7
    

    
        
        Activities/ Resources for Outcome #7 55 PowerPoint: Email Using E-mail Creating and Sending Messages The Inbox view serves as Outlook s e-mail interface Click the Inbox icon in the Outlook Bar or Folder    

    
        More information 
    




    
        Word 2010: Mail Merge to Email with Attachments
    

    
        
        Word 2010: Mail Merge to Email with Attachments Table of Contents TO SEE THE SECTION FOR MACROS, YOU MUST TURN ON THE DEVELOPER TAB:... 2 SET REFERENCE IN VISUAL BASIC:... 2 CREATE THE MACRO TO USE WITHIN    
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        Creating and Using Links and Bookmarks in PDF Documents
    

    
        
        Creating and Using Links and Bookmarks in PDF Documents After making a document into a PDF, there may be times when you will need to make links or bookmarks within that PDF to aid navigation through the    
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        Manuals for This Product
    

    
        
        Installation Guide Manuals for This Product Manuals for this product have the following structure. Read the manual according to your purpose for using this product. Disc Guides with this symbol are PDF    
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        MadCap Software. Import Guide. Flare 11
    

    
        
        MadCap Software Import Guide Flare 11 Copyright 2015 MadCap Software. All rights reserved. Information in this document is subject to change without notice. The software described in this document is furnished    
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        Using ADOBE CONTRIBUTE CS5
    

    
        
        Using ADOBE CONTRIBUTE CS5 Legal notices Legal notices For legal notices, see http://help.adobe.com/en_us/legalnotices/index.html. iii Contents Chapter 1: What s new Chapter 2: Setting up Contribute The    
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        Lotus Notes Client Version 8.5 Reference Guide
    

    
        
        Lotus Notes Client Version 8.5 Reference Guide rev. 11/19/2009 1 Lotus Notes Client Version 8.5 Reference Guide Accessing the Lotus Notes Client From your desktop, double click the Lotus Notes icon. Logging    
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        Microsoft Office 2007 Orientation Objective 1: Become acquainted with the Microsoft Office Suite 2007 Layout
    

    
        
        Microsoft Office 2007 Orientation Objective 1: Become acquainted with the Microsoft Office Suite 2007 Layout Microsoft Suite 2007 offers a new user interface. The top portion of the window has a new structure    
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        Adobe Dreamweaver CC 14 Tutorial
    

    
        
        Adobe Dreamweaver CC 14 Tutorial GETTING STARTED This tutorial focuses on the basic steps involved in creating an attractive, functional website. In using this tutorial you will learn to design a site    
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        Task Force on Technology / EXCEL
    

    
        
        Task Force on Technology EXCEL Basic terminology Spreadsheet A spreadsheet is an electronic document that stores various types of data. There are vertical columns and horizontal rows. A cell is where the    
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        WHAT S NEW IN WORD 2010 & HOW TO CUSTOMIZE IT
    

    
        
        WHAT S NEW IN WORD 2010 & HOW TO CUSTOMIZE IT The Ribbon... 2 Default Tabs... 2 Contextual Tabs... 2 Minimizing and Restoring the Ribbon... 3 Customizing the Ribbon... 3 A New Graphic Interface... 5 Live    
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        Basics of Microsoft Outlook/Email. Microsoft Outlook
    

    
        
        Basics of Microsoft Outlook/Email Microsoft Outlook Workshop Outline for Improve Your Outlook Microsoft Outlook Contents Starting the application... 3 The Outlook 2010 window... 3 Expanding and minimizing    
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        Requirements for Developing WebWorks Help
    

    
        
        WebWorks Help 5.0 Originally introduced in 1998, WebWorks Help is an output format that allows online Help to be delivered on multiple platforms and browsers, which makes it easy to publish information    
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        How to Mail Merge PDF Documents
    

    
        
        How to Mail Merge PDF Documents A step-by-step guide to creating personalized documents Table of Contents What is a mail merge?... 2 What do I need to start?... 2 Step 1: How to create a PDF document?...    
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        Redacting with Confidence: How to Safely Publish Sanitized Reports Converted From Word to PDF
    

    
        
        Report # I333-015R-2005 Date 12/13/2005 Redacting with Confidence: How to Safely Publish Sanitized Reports Converted From Word to PDF Architectures and Applications Division of the Systems and Network    
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        FileMaker Pro and Microsoft Office Integration
    

    
        
        FileMaker Pro and Microsoft Office Integration page Table of Contents Executive Summary...3 Introduction...3 Top Reasons to Read This Guide...3 Before You Get Started...4 Downloading the FileMaker Trial    
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        Working together with Word, Excel and PowerPoint
    

    
        
        Working together with Word, Excel and PowerPoint Have you ever wanted your Word document to include data from an Excel spreadsheet, or diagrams you ve created in PowerPoint? This note shows you how to    
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        Student Portfolios Department of Geological Sciences Brigham Young University
    

    
        
        Student Portfolios Department of Geological Sciences Brigham Young University This document contains information on student portfolio requirements, formatting portfolios, and how to create a portfolio    
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        Microsoft PowerPoint 2010
    

    
        
        Microsoft PowerPoint 2010 Starting PowerPoint... 2 PowerPoint Window Properties... 2 The Ribbon... 3 Default Tabs... 3 Contextual Tabs... 3 Minimizing and Restoring the Ribbon... 4 The Backstage View...    
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        Microsoft Office PowerPoint 2013
    

    
        
        Microsoft Office PowerPoint 2013 Navigating the PowerPoint 2013 Environment The Ribbon: The ribbon is where you will access a majority of the commands you will use to create and develop your presentation.    
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        Adobe Acrobat X Pro Creating & Working with PDF Documents
    

    
        
        Adobe Acrobat X Pro Creating & Working with PDF Documents Overview Creating PDF documents is useful when you want to maintain the format of your document(s). As a PDF document, your file maintains its    
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        Creating Digital Signatures
    

    
        
        About Security You can secure a PDF using any of the following security methods: Add passwords and set security options to restrict opening, editing, and printing PDFs. Encrypt a document so that only    
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        Sharing Files and Whiteboards
    

    
        
        Your user role in a meeting determines your level of file sharing. The type of files you can share include documents, presentations, and videos. About Sharing Files, page 1 Changing Views in a File or    
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        Build Electronic Portfolios using Windows and PDFMaker
    

    
        
        Build Electronic Portfolios using Windows and PDFMaker In Word or PowerPoint (or your favorite application whatever you can print to a printer you can turn into a PDF file if you have the full version    
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        Designing forms for auto field detection in Adobe Acrobat
    

    
        
        Adobe Acrobat 9 Technical White Paper Designing forms for auto field detection in Adobe Acrobat Create electronic forms more easily by using the right elements in your authoring program to take advantage    
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        Website Editor User Guide
    

    
        
        CONTENTS Minimum System Requirements... 3 Design Your Website... 3 Choosing your Theme... 4 Choosing your Header Style... 4-5 Website Content Editor... 6 Text Editor Toolbar features... 6 Main Menu Items...    
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        SMART Ink 1.5. Windows operating systems. Scan the following QR code to view the SMART Ink Help on your smart phone or other mobile device.
    

    
        
        SMART Ink 1.5 Windows operating systems User s guide Scan the following QR code to view the SMART Ink Help on your smart phone or other mobile device. Trademark notice SMART Ink, SMART Notebook, SMART    
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        Import Data to Excel Start Excel.
    

    
        
        Step-By-Step EXERCISE 5-1 Import Data to Excel Start Excel. Excel can import data, or bring it in from other sources and file formats. Importing Open the data fi le data is useful because it prevents you    
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        Creating Fill-able Forms using Acrobat 8.0: Part 1
    

    
        
        Creating Fill-able Forms using Acrobat 8.0: Part 1 The first step in creating a fill-able form in Adobe Acrobat is to generate the form with all its formatting in a program such as Microsoft Word. Then    
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        Optimizing Adobe PDF files for display on mobile devices
    

    
        
        whitepaper TABLE OF CONTENTS 1 Introduction 1 Part I. Optimizing existing PDF files 5 Part II. Creating optimized PDF files Introduction This document provides guidelines for creating Adobe PDF files optimized    
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        Creating Hyperlinks & Buttons InDesign CS6
    

    
        
        Creating Hyperlinks & Buttons Adobe DPS, InDesign CS6 1 Creating Hyperlinks & Buttons InDesign CS6 Hyperlinks panel overview You can create hyperlinks so that when you export to Adobe PDF or SWF in InDesign,    
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        BAT Smart View for Budget Users. Miami-Dade County. BAT Smart View Training Activity Guide
    

    
        
        Miami-Dade County BAT Smart View Training Activity Guide 1 Table of Contents Activity 1: Launch Microsoft Excel, Check User Options and Use the Connection Panel.... 3 Activity 2: Opening BAT Web Forms    
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        Chapter 10 Printing, Exporting, and E-mailing
    

    
        
        Getting Started Guide Chapter 10 Printing, Exporting, and E-mailing This PDF is designed to be read onscreen, two pages at a time. If you want to print a copy, your PDF viewer should have an option for    
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        Chapter 19: XML. Working with XML. About XML
    

    
        
        504 Chapter 19: XML Adobe InDesign CS3 is one of many applications that can produce and use XML. After you tag content in an InDesign file, you save and export the file as XML so that it can be repurposed    
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        Working together with Word, Excel and PowerPoint 2013
    

    
        
        Working together with Word, Excel and PowerPoint 2013 Information Services Working together with Word, Excel and PowerPoint 2013 Have you ever needed to include data from Excel or a slide from PowerPoint    
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        Release 2.1 of SAS Add-In for Microsoft Office Bringing Microsoft PowerPoint into the Mix ABSTRACT INTRODUCTION Data Access
    

    
        
        Release 2.1 of SAS Add-In for Microsoft Office Bringing Microsoft PowerPoint into the Mix Jennifer Clegg, SAS Institute Inc., Cary, NC Eric Hill, SAS Institute Inc., Cary, NC ABSTRACT Release 2.1 of SAS    
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        MICROSOFT OUTLOOK 2011 READ, SEARCH AND PRINT E-MAILS
    

    
        
        MICROSOFT OUTLOOK 2011 READ, SEARCH AND PRINT E-MAILS Lasted Edited: 2012-07-10 1 Find the Inbox... 3 Check for New Mail... 4 Manually check for new messages... 4 Change new incoming e-mail schedule options...    
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        Create Mailing Labels from an Electronic File
    

    
        
        Create Mailing Labels from an Electronic File Microsoft Word 2002 (XP) Electronic data requests for mailing labels will be filled by providing the requester with a commadelimited text file. When you receive    
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        Microsoft Office 2013
    

    
        
        Student manuals available at: www.learnit.com/manuals Username: manuals; Password: password Microsoft Office 2013 New Features Take this class home with you! Student Videos Available at: www.learnitanytime.com    
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        dopdf dopdf User Manual dopdf does PDF. For free. Copyright 2015 Softland
    

    
        
        does PDF. For free. User Manual User Manual for version 8 by Softland This documentation contains proprietary information of Softland. All rights reserved. No part of this documentation shall be reproduced,    
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        Guide to Creating Electronic Appellate. I. Briefs II. Appendices III. Hyperlinking
    

    
        
        Guide to Creating Electronic Appellate I. Briefs II. Appendices III. Hyperlinking California Courts of Appeal 1/1/2016 Page 2 Introduction This guide was created to help filers provide working electronic    
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        Mastering Mail Merge. 2 Parts to a Mail Merge. Mail Merge Mailings Ribbon. Mailings Create Envelopes or Labels
    

    
        
        2 Parts to a Mail Merge 1. MS Word Document (Letter, Labels, Envelope, Name Badge, etc) 2. Data Source Excel Spreadsheet Access Database / query Other databases (SQL Server / Oracle) Type in New List Mail    
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        SAP BUSINESS OBJECT ANALYSIS FOR EXCEL DEVELOPER GUIDE
    

    
        
        STEP 1: Log on to Business Object Analysis for Excel. Path: Start All Programs SAP Business Intelligence Analysis for Microsoft Excel Click Microsoft Excel will appear Figure 1 STEP 2: Choose Microsoft    
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        Sharing a Screen, Documents or Whiteboard in Cisco Unified MeetingPlace
    

    
        
        Sharing a Screen, Documents or Whiteboard in Cisco Unified MeetingPlace Release: 7.0 Revision Date: December 9, 2009 1:29 pm This section describes how to use the features in the Cisco Unified MeetingPlace    
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        For Organizers (Hosts) at OSU
    

    
        
        Adobe Connect Pro 9.1 Overview For Organizers (Hosts) at OSU Getting Started 1. Access Adobe Connect Pro Central via this URL: http://oregonstate.adobeconnect.com 2. Login using your email address and    
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        COGNOS 8 Business Intelligence
    

    
        
        COGNOS 8 Business Intelligence QUERY STUDIO USER GUIDE Query Studio is the reporting tool for creating simple queries and reports in Cognos 8, the Web-based reporting solution. In Query Studio, you can    
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        Colligo Email Manager 6.0. Offline Mode - User Guide
    

    
        
        6.0 Offline Mode - User Guide Contents Colligo Email Manager 1 Key Features 1 Benefits 1 Installing and Activating Colligo Email Manager 2 Checking for Updates 3 Updating Your License Key 3 Managing SharePoint    
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        Oregon State Bar Software Standards 2005. Software Proficiency Expectations (Items in bold are to be demonstrated)
    

    
        
        Oregon State Bar Software Standards 2005 Computer Basics (all users) Software Proficiency Expectations (Items in bold are to be demonstrated) Touch typing (at least 25 words per minute). Starting, shutting    
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        Quick Reference Guide
    

    
        
        Quick Reference Guide 2 This Guide shows screen pictures made with Windows XP. The appearance may vary under other Operating Systems. Why are PDF files popular? The Portable Document Format has become    
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